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Using Presentation Studio

OverviewIn Morningstar DirectSM, Presentation Studio is the tool for creating custom 
presentations. With flexible charting and reporting capabilities, and access to 
Morningstar databases, Presentation Studio helps you communicate the data behind 
investments. You have control over both the content and format of your presentations, 
enabling you to use charts, tables, images, and text to tell your story.

This guide describes the following topics:

g Introducing Presentation Studio (page 7)
gWorking with Factsheets and Workbooks (page 21)
gWorking with a Template (page 24)
gWorking with Chart and Table Components (page 40)
gUsing Workbook Settings and Component Settings (page 62)
gCreating a New Page (page 79)

Presentation Studio uses 
charts, tables, images, and text 
to communicate information 
about investments.
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gCustomizing a Component (page 87)
gWorking with Headers, Footers, Images, and Watermarks (page 96)
gCreating a Template (page 114)
gPublishing a Presentation Studio Template (page 122)
gCreating a Batch Report (page 126)
gUsing Components with Nonstandard Features (page 135)



Presentation Studio September 2018 7
© 2018 Morningstar. All Rights Reserved.

Introducing Presentation Studio Overview

Introducing Presentation Studio

OverviewPresentation Studio uses Morningstar data (as well as custom data, model portfolios, 
and custom benchmarks) to allow you to create reports with a predefined layout and 
look, or one of your own design. You can present information in a variety of charts, 
tables, and images, along with analysis and commentary from Morningstar Research.

This section helps you understand the following:

gPresentation Studio terminology (page 7)
gwhat you can create in Presentation Studio (page 9)
ghow to launch Presentation Studio (page 12)
gwhat you can do on the Presentation Studio Home page (page 14)
gwhat you can do in the Application Settings (page 16)
ghow to change the colors used in charts throughout Presentation Studio 

(page 16), and
ghow Application Settings, Workbook Settings, and Component Settings relate to 

each other (page 19).

What Presentation 
Studio terminology 
do I need to know?

Some of the terms used in Presentation Studio and this guide might be new to you. 
They are defined in this table.

Term Definition

Factsheet A factsheet is a document containing information (rating, 
performance, holdings, and so on) about an investment. It cannot 
present information for multiple investments at once. It typically 
presents key data as tables, charts, and text. To view a sample, see 
What is a factsheet? on page 21.

Workbook A workbook is a detailed document (usually multiple pages) 
containing comprehensive information (rating, performance, 
holdings, and so on) on up to 50 investments. It is frequently used 
to compare investments or model portfolios. To view a sample, see 
What is a workbook? on page 23.

Report A report is a document reflecting information for a specific 
investment (or investments, in the case of a workbook). In this 
guide, a report is a factsheet or a workbook.

Template A template is a Presentation Studio document created to serve as 
the basis for a specific type of report. A template typically contains 
text, charts, tables, and images selected to present information in 
service of the template’s purpose. When a template is used as the 
basis for a report, its content updates to reflect the investment(s) 
selected for inclusion in the report. For more information, see 
Working with a Template on page 24.
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Morningstar template A Morningstar template is created by Morningstar experts to serve 
as the basis for a specific type of report. Morningstar templates are 
included in Presentation Studio. For more information, see Working 
with a Template on page 24.

Component A component is an element used to present a specific type of 
information about an investment or investments. Tables, charts, 
text, and images are components. Each of these is described in 
this guide.

Component category Tables and charts are categorized by function. For instance, 
Markets, Time Series, and Holdings Analysis are different 
component categories. Markets charts include Markets Growth 
and Markets Trailing Returns Bar Chart, among others. Markets 
tables include Markets Summary and Markets Historical 
Performance, among others. For more information, see Working 
with Chart and Table Components on page 40.

Term Definition
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What can I create in 
Presentation Studio?

In Presentation Studio, you can create a variety of reports: workbook, factsheet, and 
retirement plan review, to name only a few. 

The exciting part of Presentation Studio is that you can use Morningstar data and 
research in a graphic page layout.

 Note: If you have not worked with page layout before, don’t worry. The processes presented in 
this guide do not require a background in design.

For instance, you can have a page divided into sections and laid out like this:

The cells are 
outlined in light blue
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Introducing Presentation Studio What can I create in Presentation Studio?

With a few clicks, you can populate it with data and Morningstar research content, so 
it looks like this:

Each cell now contains a chart, 
table, or text representing 
Morningstar data and analysis.
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Introducing Presentation Studio What can I create in Presentation Studio?

A report can contain many pages, and each page can have a different layout.

The three pages shown here are 
all from a single Presentation 
Studio workbook
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Introducing Presentation Studio Exercise 1:   Launch Presentation Studio

Exercise 1:   Launch 
Presentation Studio

After logging into Morningstar Direct, select the Presentation Studio module. 

Select the Presentation 
Studio module to open 
the Presentation Studio 
Home page.
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The Presentation Studio Home page opens.

From here, you can 
create new reports and 
templates, as well as 
access existing ones.
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What can I do on 
the Presentation 
Studio Home page?

The Home page is the starting point for your work in Presentation Studio. From here, 
you can open an existing report or template, or create a new report or template.

 Note: See What Presentation Studio terminology do I need to know? on page 7 to review the 
definitions of workbook, factsheet, template, and other terms.

A. Click the Application Settings icon to open the Application Settings. For information 
about the Application Settings, see What can I do in the Application Settings? on 
page 16.

B. Click a tile to create a new report of that type.

C. Minimize bar

A. Application Settings icon

B. Tiles
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Introducing Presentation Studio What can I do on the Presentation Studio Home page?

C. Click the Minimize bar to reduce the size of the top portion of the Home page.

 Note: The Minimize bar is especially useful when viewing Presentation Studio on a 
small screen

D. On the toggle, click a selection to display a list of Morningstar Templates, your 
templates (My Templates), or your reports (My Reports).

E. The list reflects the selection on the toggle. From the list, you can do the following:
g Double-click an entry to open that template or report;
g Sort on any column by clicking the column header (Name, Type, and so on);
g Scroll down to see more list entries; and
g Scroll right to display additional columns (Version, Owner, Permission, Date 

Created, and Date Modified).

C. If the top portion of 
the Home page is 
minimized (shown here), 
click the Minimize bar 
maximize it 

D. Toggle

E. List of templates 
or reports
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What can I do in the 
Application Settings?

The Application Settings are comprised of options you can use to customize 
Presentation Studio. The following are a few examples of features controlled in the 
Application Settings window:

g language used in your reports
g fonts used in various text elements
g start and end dates used in your reports
g custom groupings, and 
gdefault Display benchmarks.

The Application Settings affect reports and templates created in your installation of 
Presentation Studio. In general, the settings apply only to new reports and templates; 
existing reports and templates are not affected.

Exercise 2:   Change 
the colors used in charts

As an example of changing an application setting, update the colors used for charts to 
reflect those of your firm.

To change the default colors to be used in charts, do the following:

1. On the Presentation Studio Home page, in the upper-right corner, click the Application 
Settings icon. The Application Settings window opens.

Click here to access the 
Application Settings.
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2. Select the Display tab. 

3. Click the Investment 1 row to select it. 

4. From the Color drop-down field, select Magenta.

The Display tab 
shows the color used 
to represent each 
investment in charts.

Each tab offers options 
for different aspects 
of reports.

The yellow background 
indicates the selected row.
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Introducing Presentation Studio Exercise 2:   Change the colors used in charts

5. Click the Investment 2 row to select it. 

6. From the Color drop-down field, select Dark green.

7. Click OK. The Application Settings window closes.

These colors are used in the reports you create from this point on.

You can also select colors for 
Display Benchmarks and the 
Category Averages.
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Introducing Presentation Studio
How do Application, Workbook, and Component Settings relate to each 

other?

How do Application, 
Workbook, and 
Component Settings 
relate to each other?

In addition to Application Settings (which affect every new template and report you 
create), Presentation Studio includes two sets of more granular settings—Workbook 
Settings and Component Settings. It is important to understand how Application 
Settings, Workbook Settings, and Component Settings relate to each other, as 
summarized in the following table:

Suppose you are working on a report based on a template with a rolling window 
setting of three years. The template perfectly suits the report with one exception: you 
need to display a rolling window of one year throughout the report. Using Workbook 
Settings, you can change the rolling window setting for the report, without affecting 
other reports or templates.

Now, let’s further suppose that in this report (which now displays one-year rolling 
window data), you want a specific component to display a two-year rolling window. 
Using Component Settings, you can change the rolling window setting for the specific 
component, without affecting other components in the report.

What happens to a component with a custom setting if the Workbook Settings for the 
report or Application Settings change in a way that conflicts with the component’s 
settings? The custom component setting is not affected by the change in Workbook or 
Application Settings. 

When you 
customize a 
setting here… This is the effect…

Application Settings The new setting is applied to every template and report you 
create from this point on. Existing templates and reports are not 
affected, with the exception of time periods (discussed later in 
this guide).

Workbook Settings The new setting overrides the similar setting in Application 
Settings. The workbook setting is applied throughout the report 
(except in individual components with different customization in 
the setting, which is described later in this section). The new 
setting also affects any components you later add to the report. 
Finally, if you use the report as the basis for another report or a 
template, the Workbook Settings are in effect in the new report 
or template. 

Component Settings The new setting overrides any similar setting in Workbook 
Settings, but for only the selected component. If a report with 
a custom setting in a component is used as the basis for another 
report or a template, the new setting is in effect in the 
component in a new report or template. In other words, the 
components in the new report or template displays one-year 
rolling windows, except for the one component, which displays 
a two-year rolling window.
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Introducing Presentation Studio
How do Application, Workbook, and Component Settings relate to each 

other?

Think of it like this: the smaller the setting’s impact, the more powerful it is, as follows:

gApplication Settings have a large impact, affecting all reports and templates you 
create from that point on

gWorkbook Settings affect only one report. They have a smaller impact than 
Application Settings, therefore Workbook Settings take precedence over 
Application Settings, but only in a single report; and

gComponent Settings affect only one component. They have the smallest impact of 
all; therefore Component Settings take precedence over Workbook Settings, but 
only in a single component.

Exercises using Workbook Settings and Component Settings are covered later in 
this guide.
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Working with Factsheets and Workbooks

OverviewThis guide contains information about the most common Presentation Studio reports—
workbooks and factsheets. Whether you are working with a factsheet or a workbook, 
the same charts, tables, and research content are available.

 Note: In this guide, when information is applicable to both a workbook and factsheet, the 
word “report” is used to mean “workbook or factsheet.”

In this section, you will learn the following:

gwhat a factsheet is (page 21), and
gwhat a workbook is (page 23).

What is a factsheet?A factsheet is a document containing information (rating, performance, holdings, and 
so on) about an investment. It cannot depict information for multiple investments. It 
presents key data as tables, charts, and text. 

The sample shown on the next page is based on the Morningstar template for an 
Investment Detail Report and has a portrait layout (8.5" wide by 11" tall). 
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Working with Factsheets and Workbooks What is a factsheet?

The called-out features are described in Working with a Template on page 24.

Table

Chart

Dynamic Text
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Working with Factsheets and Workbooks What is a workbook?

What is a workbook?A workbook is a detailed document (usually multiple pages) containing comprehensive 
information (rating, performance, holdings, and so on) for up to 50 investments. It is 
frequently used to compare investments or model portfolios.

The sample page shown here is based on the Morningstar template for an Equity 
Manager Analysis workbook and has a landscape layout (11" wide by 8.5" tall).

Table

In the 
Navigation 
pane, click a 
page icon to 
display 
that page.

Table

Chart
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Working with a Template

OverviewIn Presentation Studio, the simplest way to create a new report is to base it on a 
template or an existing report.

The section helps you understand the following:

gwhy you should use a template or an existing report to create a new report 
(page 24)

ghow to select a template for a new report (page 25)
ghow to use Search to select an investment for a new report (page 27)
ghow to create a list of investments (page 34) and
ghow to use a saved list to select investments to a new report (page 35).

You can customize the layout and content of your report, but keep in mind that the 
person who created the template (also referred to as the template builder) might have 
set limitations on what you can do.

In this section, you will work with the Morningstar Investment Performance factsheet 
template. The process can also be used when working with a workbook template; a 
portfolio template, however, is different. Working with a portfolio template is discussed 
in Creating a Template on page 114.

Why should I 
use a template or 
an existing report to 
create a new report?

By using a template or existing report as a starting point, you can create a new report 
in a few simple steps. 

Morningstar factsheet templates are designed to summarize data and information 
about one investment. Morningstar workbook templates are designed to 
comprehensively illustrate data and information about multiple investments. 
Morningstar templates have been designed for many different scenarios (such as Stock 
Analysis and Attribution Highlights), but the steps for using a template are consistent 
throughout Presentation Studio.

If you want your report to closely resemble a Morningstar template, a custom template, 
or an existing report, the overall process is as follows:

1. Open a template or report with design and content similar to what you want to create.

2. Select the investment(s) to be reflected in your report. 

3. (Optional) Select the benchmarks to be used for comparison in your report

4. (Optional) Modify the design (colors, font, page layout, and so on) and content (charts, 
text, tables, and so on).
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Working with a Template Exercise 3:   Select a template

Exercise 3:   Select 
a template

In this exercise, the Morningstar Investment Performance Factsheet template is used 
to demonstrate the process of working with a factsheet template; however, the steps 
for using any Morningstar template, a custom template, or an existing report are the 
same, except where noted.

To create a new factsheet from a template, do the following:

1. On the Presentation Studio Home page, on the toggle, be sure the Morningstar 
Templates tab is selected. 

The list of Morningstar template categories opens, displaying the following:
g Asset Allocation
g Factsheets, and 
g Workbooks.

 Note: If you had selected My Templates, the list would display the custom templates available 
to you. If you had selected My Reports, the list would display your existing reports.

2. Click the arrow to the left of Factsheets. The Factsheet category expands to display the 
Morningstar Factsheet templates.

Click once to view 
this list.

Click here to expand this option.

If you 
cannot see 
all columns 
shown here, 
scroll right.
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Working with a Template Exercise 3:   Select a template

3. Initially, the templates (or reports) are listed alphabetically. You can sort on any column 
by clicking the column heading. Click the Layout column heading. The list sorts on that 
column and an arrow appears next to the heading. To reverse the sort order, click the 
arrow next to the heading. 

4. In the list, scroll down and double-click Investment Performance Factsheet. 

The Investments: Settings dialog box opens.

When you sort on 
the Layout column, 
all the Landscape 
templates are 
displayed together 
at the top of the list, 
and all the Portrait 
templates are 
further down.

Open this template.

The dialog box 
shows the 
default 
calculation 
benchmarks, 
display 
benchmarks, 
and 
other settings.
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Working with a Template Exercise 4:   Select an investment

Exercise 4:   Select 
an investment

In the Investments: Settings dialog box, changing the default selections for 
benchmarks, colors, and so on is optional, but you must select at least one investment 
to be the focus of the report.

In the Investments: Settings dialog box, the following fields are not filled in:

gName
g Inception Date
gCategory, and
gDisplay Name.

When you have selected an investment and it is displayed in the Name field, the 
Inception Date, Category, and Display Name fields auto-fill.

In this exercise, search for an investment to populate the factsheet. Do the following:

1. In the Investments: Settings dialog box, in the Name column, click the Search icon. The 
Find Investment dialog box opens. 

 Note: When creating a new workbook, you can also use search to select multiple investments.

You must select 
an investment 
for a factsheet 
or investments 
for a workbook.

A factsheet template 
allows you to search for 
only one investment.
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Working with a Template Exercise 4:   Select an investment

2. In the Within area, click the Universes button, and from the drop-down field, select 
Open End Funds.

3. In the Find By text field, type Fidelity Contrafund. 

In the Open End Funds universe, you are searching for investments whose names begin 
with Fidelity Contrafund.

 Note: Users who have access to the HFR database can select an HFR fund when setting up a 
workbook or factsheet. The data populates using monthly returns.

You can also search your 
lists and saved searches.
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Working with a Template Exercise 4:   Select an investment

4. Click Go. The investments meeting your search criteria are shown in the Available 
records list.

Two funds meet the search criteria.
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Working with a Template Exercise 4:   Select an investment

5. In the Available Records list, select Fidelity® Contrafund® 
(USD,XNAS,FCNTX,Port+Perf,Oldest,RepPerf). 

 Note: Even if only one fund is displayed in Available Records, you must still select it to add it to 
the report.

6. Click OK. The Investment Settings dialog box is displayed. 

More than one fund might 
be displayed in the 
Available Records list.

The highlighted 
settings 
automatically 
populate based 
on the selected 
investment.
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Working with a Template Exercise 4:   Select an investment

7. Click OK to close the dialog box. The factsheet window opens. The layout of the charts, 
tables, and text was predetermined in the template, but the content is specific to the 
investment you selected.

The most current 
Morningstar data 
and information on 
Fidelity Contrafund 
is displayed.
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8. At the top-left corner of the window, click the Application Settings icon and from 
the menu, select Save As to give the report a name and save it. A dialog box opens. 

It is important to understand the Save options, which are described in the 
following table:

When you are 
working in a… And you select… The result is…

Report Save The report is updated.

Save As A copy of the report is created as a new 
report (with a name you enter). The 
original report is unchanged from the 
last time you saved it.

Save As Template A copy of the report is created as a 
template (with a name you enter). The 
original report is unchanged from the 
last time you saved it.

Template Save If you built the template, it is updated. If 
you did not build the template (for 
example, a Morningstar template), your 
work is saved as a report. The template 
is unchanged.

Save As A copy of the template is created as a 
report (with a name you enter). In other 
words, when you are working with a 
template (as you are here) and you 
select Save As, a report is created. The 
template is unchanged.

Save As Template A copy of the template is created as a 
new template (with a name you enter). 
The original template is unchanged.

When you are creating a new report based 
on a template or existing report, be sure to 
select Save As), not Save (which overwrites 
the template or existing report)
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Working with a Template Exercise 4:   Select an investment

9. In the Factsheet Name field, type FCNTX Factsheet, then click Save. 

The report is stored in the My Reports folder and listed on the Presentation Studio Home 
Page when My Reports is selected on the toggle.

 Note: On the Presentation Studio Home page, the new report is initially shown at the bottom 
of the My Reports list.

You can use spaces 
in report names.

If you want to 
immediately move 
the report into place 
in alphabetical 
order, sort the 
Name column.
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Working with a Template Exercise 5:   Create a list of investments

10. Close the factsheet by doing one of the following:

g Click the Application Settings icon and select Exit, or
g Click the Close icon (X) in the upper-right corner of the window.

 Note: You can have only one report open at a time.

Exercise 5:   Create a 
list of investments

In the next exercise, you need a list of investments. You can use one of your existing 
lists, but you might find it easier to follow the steps in this guide if you replicate the list 
used here.

To create a list matching the one in the exercise, do the following:

1. In Morningstar Direct, create a list containing the following investments:

 Note: The tickers are shown in parentheses so that if you want, you can use them when 
creating the list.

g ProShares Large Cap Core Plus (CSM) 
g ProShares S&P 500 Dividend Aristocrats (NOBL)
g Vanguard S&P 500 ETF (VOO) 
g PSDR SSGA US Large Cap Low Volatility ETF (LGLV), and
g iShares Morningstar Large-Cap ETF (JKD).

2. Name the list Large Blend ETFs.

If you try to close a report with 
unsaved changes, you are 
prompted to save.
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Working with a Template Exercise 6:   Select investments from a saved list

Exercise 6:   Select 
investments from 
a saved list

In this exercise, you will create a new workbook by selecting multiple investments from 
a saved list.

The Morningstar template, Equity Manager Analysis, is used to demonstrate the 
process of using a workbook template; however, the steps for using any Morningstar 
template, a custom template, or an existing report are the same, except where noted.

 Note: To follow the steps here, you need a saved list with multiple managed investments, 
such as equity funds or equity ETFs. If you created the list Large Blend ETFs in the previous 
exercise, please use it here.

To add investments from a saved list to a new workbook, do the following:

1. On the Presentation Studio Home page, on the toggle, be sure the Morningstar 
Templates tab is selected. 

2. Click the arrow to the left of Workbooks. The Workbooks category expands to display the 
Morningstar workbook templates.

Be sure this option 
is selected.

Click here to expand this option
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Working with a Template Exercise 6:   Select investments from a saved list

3. In the list, double-click Equity Manager Analysis. (You might need to scroll down to 
find this template.) The Investments: Settings dialog box opens.

 Note: In this exercise, the Equity Manager Analysis template is used to compare two funds.

4. In the Investments: Settings dialog box, from the Saved Lists drop-down field, select  
the name of a saved list. The Investments: Setting dialog box displays the investments 
from the selected list.

Open this template.

A saved list allows you to quickly 
access investments you have worked 
with before.
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Working with a Template Exercise 6:   Select investments from a saved list

5. In the Show column, note that the five checkboxes at the top of the list are selected

6. If an investment’s Show checkbox is not checked, it will not be included in the workbook. 
To include only the top two investments in the workbook, clear the checkboxes for the 
other investments.

In a list of multiple 
investments, the 
Show checkboxes 
are checked for 
the top five 
investments.

These investments 
are the focus of 
the workbook
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Working with a Template Exercise 6:   Select investments from a saved list

7. Click OK. The new workbook opens.

8. At the top-left corner of the Presentation Studio window, click the Application Settings 
icon and select Save As. A dialog box opens.

In the 
Navigation 
pane, click a 
page icon to 
view the page; 
scroll to view 
additional 
page icons.

When you are creating a new report based on a 
template, be sure to select Save As), not Save 
(which overwrites the template).
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Working with a Template Exercise 6:   Select investments from a saved list

9. In the dialog box, in the Workbook Name field, enter ProShares-Vanguard then 
click Save.

The report is stored in the My Reports folder and listed on the Presentation Studio Home 
Page when My Reports is selected on the toggle. 

10. Close ProShares-Vanguard by doing one of the following:

g Click the Application Settings icon and select Exit, or
g Click the Close icon (X) in the upper-right corner of the window.

Once saved, you can access the 
workbook from the Presentation 
Studio Home page.

If you try to close a report 
with unsaved changes, you 
are prompted to save.
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Working with Chart and Table Components

OverviewComponents—charts, tables, and text—comprise the main content of a report. 
The look of the components (color, font, title, and so on), as well as some of the content 
(such as category and date range), is determined by settings in the following:

g the Presentation Studio Application Settings
g the Investments Settings
g the Workbook Settings, and
g the Component Settings.

 Note: On a page with multiple components, you might need to zoom in to see a component 
more clearly or zoom out to view more of the page.

A Morningstar template contains charts, tables, text, and research content selected by 
Morningstar analysts to best serve that template’s purpose, but you can easily replace, 
change, or delete any component.

 Note: The same components are available in both factsheets and workbooks; however, 
plan reviews and portfolios are more limited. Plan reviews and portfolios are not covered in 
this guide.

This section helps you do the following:

gunderstand what the Command bar is (page 41)
guse the Command bar to replace a component (page 41)
gunderstand what the Component bar is (page 47)
guse the Component bar to replace a component (page 48)
g resize a cell (page 51)
g rearrange components (page 54)
gdelete a component (page 58), and
g remove a cell (page 60).

Drag the control on 
the Zoom slider to 
enlarge or reduce 
the display.
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Working with Chart and Table Components What is the Command bar?

What is the 
Command bar?

At the top of the Presentation Studio window, you see the Command bar, from which 
you can access many of the design and content tools. The Command bar has four 
tabs—Home, Chart, Data Table, and Format. Within each of the tabs, icons are 
categorized by action. For instance, on the Home tab, the Insert category contains the 
tool icons Page, Chart, Table, Text, and Image—elements you would insert in a report.

Exercise 7:   Use 
the Command bar 
to replace a component

You might decide an existing component does not significantly contribute to 
your presentation and a different component (not currently in the report) would be 
more useful. 

When replacing components, you should understand the following:

gA table can be replaced with a chart and vice versa.
gA component from one category can be replaced with a component from another 

category, and
gA table component requiring a full page (represented by a green icon on the 

Component bar) cannot replace a component in a cell occupying only part of 
a page.

The Command bar

The tools available in 
the selected 
Command Bar tab

The action categories 
(Setting, Insert, Layout, and 
so on).
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To use the Command bar to replace a component, do the following:

1. On the Presentation Studio Home page, on the toggle, select My Reports, then in the 
list of your reports, double-click FCNTX Factsheet.

2. On the Command bar, be sure the Home tab is selected.

3. Click the Chart icon. 

Double-click here to open 
the report.

Note the 
highlighted 
selections.
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The Chart menu opens, displaying the chart categories (Markets, Performance, and so 
on). When you select a category from the Chart menu, a window opens to the right, 
showing representations and names of the chart components in that category.

4. Click the Table icon. The Table menu opens, displaying the table categories (Markets, 
Performance, and so on). When you select a category from the Table menu, a window 
opens to the right showing graphic representations and names of the table components 
in that category.

Charts in the Markets category

Tables in the Attribution category
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Notice the Performance Relative to Peer Group chart near the top of the report. 

The charts and tables 
are in the report 
because they were in 
the template, but the 
data is specific to the 
fund—in this case, 
Fidelity Contrafund.



Presentation Studio September 2018 45
© 2018 Morningstar. All Rights Reserved.
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5. To replace the Performance Relative to Peer Group chart with a Snapshot Data Relative 
to Peer Group chart, select the Home tab, then select Chart…Snapshot.

6. Drag the Snapshot Data Relative to Peer Group icon to anywhere in the cell occupied 
by the Performance Relative to Peer Group chart. 

 Note: The area containing a component is called a cell.

7. In the chart, click Calculate.

The new 
component 
proportionally 
sizes to fit 
the cell.

Peer group data refreshes daily; 
therefore, the Calculate button 
appears in components associated 
with a peer group.
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When the calculation finishes, the Snapshot Data Relative to Peer Group chart is 
displayed and reflects the current data.

8. To save your work, click the Application Settings icon at the top-left corner of the 
window and select Save.

The Snapshot Data 
Relative to Peer 
Group chart now 
occupies the cell.

Note the highlighted selections.
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What is the 
Component bar?

At the bottom of the Presentation Studio window, you see the Component bar, which is 
another way to access the chart and table components for your report. The Component 
bar displays the following:

g the Component Category button
g the Component Settings button, which displays either Chart Settings or Table 

Settings, and
g icons representing tables and charts in the selected component category.

 Note: You cannot insert images or text components from the Component bar. 

This table lists the component categories (indicated by different colors) displayed in the 
component bar.

In the Component bar, when you hover the cursor over a component icon, the icon 
enlarges and a pop-up opens, displaying the component name and a representation of 
the chart or table.

This color… represents this type of component…

Blue A chart

Orange A table

Green A table requiring a full page

 Note: The tables requiring a full page are Performance Reporting (Extended), 
Holding Intersection, and Leading Contributors/Detractors.

Component Category Component Settings Table and chart icons

If you drag the cursor across the 
Component bar, pop-ups open 
as the cursor passes each icon.
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Exercise 8:   Use 
the Component bar 
to replace a component

You might decide an existing component does not contribute significantly to 
your presentation, and a different component (not currently on the page) would be 
more useful. You can select a chart or table icon from the Component bar.

 Note: You cannot access text components from the Component bar.

When replacing components, you should understand the following:

gA table can be replaced with a chart and vice versa.
gA component from one category can be replaced with a component from another 

category, and
gA table component requiring a full page (represented by a green icon on the 

Component bar) cannot replace a component in a cell occupying only part of 
a page.

In this exercise, a chart (Rolling Performance - 36 month rolling window) is replaced 
with a table (Leading Contributors).

To use the Component bar to replace a component, do the following:

1. With the FCNTX Factsheet report open, at the bottom-left corner of the Presentation 
Studio window, click the Component Category button. The Component Category 
menu opens above the button.

2. Select Holdings Analysis. The icons on the Component bar now display only the 
components in the Holdings Analysis category.

The Component Category menu 
displays the same categories 
available on the Command bar.

Click the Component Category 
button to access the 
Component Category menu.

You night need to 
scroll to see more 
component icons.



Presentation Studio September 2018 49
© 2018 Morningstar. All Rights Reserved.

Working with Chart and Table Components Exercise 8:   Use the Component bar to replace a component

3. Notice the Rolling Performance - 36 month rolling window chart on the left side of the 
report. Replacing one component with another is a simple drag-and-drop action. To 
replace the Rolling Performance - 36 month rolling window chart with a Leading 
Contributors table, from the Component bar, drag the Leading Contributors table to the 
cell occupied by the Rolling Performance - 36 month rolling window chart. The new 
component proportionally resizes to fit the cell. 

4. If necessary, click Calculate.

Drag the Leading 
Contributors icon to 
the cell occupied by 
the Rolling 
Performance chart.

Click here to access the 
most current data.
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When the calculation finishes, the Leading Contributors table is displayed.

5. To save your work, click the Application Settings icon at the top-left corner of the 
window and select Save.

You have replaced 
a chart from the 
Performance category 
with a table from 
the Holdings 
Analysis category.

Note the highlighted selections.
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Exercise 9:   Resize a cellAlthough Morningstar templates are laid out carefully, they cannot account for 
all possibilities. Take a look at the FCNTX Factsheet and notice the following:

g The unlabeled table above the Leading Contributors table does not vertically fill its 
cell, and

g The Leading Contributors table looks crowded.

The page would look better if the Leading Contributors table had more space and the 
table above it had less. That sounds like a two-step process (enlarge one cell and 
decrease the other), but it is actually only one. Simply move the border between the 
two cells. When you enlarge a cell, an adjacent cell is decreased by the same amount 
(and vice versa).

For instance, if you add space to the top of a cell (in other words, move its top border 
up), the cell above it shrinks.

To resize a cell, do the following:

1. Select the Leading Contributors table and hover the cursor over its top border. A 
two-headed arrow appears.

This arrow can be dragged up or down.
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2. Drag the arrow up to enlarge the cell containing the Leading Contributors table.

 Note: To resize a cell horizontally, select the cell, hover the cursor over one of the side borders, 
then drag the arrow left or right.

3. As you drag the arrow, use the rulers at the top and left of the page as a guide. Release 
the cursor when the ruler displays approximately 4.7".

As you resize a cell, the top 
and side rulers display the 
position of the border.
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The result should now look like this.

4. Click the Application Settings icon at the top-left corner of the window and select Save.

5. Close FCNTX Factsheet.

The components in 
the right column 
have not been 
affected by the 
changes to 
components in the 
left column.

Be sure to save frequently.
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Exercise 10:   Rearrange 
components

You might want two components to switch places. For instance, if a component of 
particular relevance to the report is displayed at the bottom of a page, and a less 
relevant component is displayed at the top of the page, you might want the two 
components to switch places. 

 Note: In this exercise, swapping the positions of two components on the same page is 
described, but you can also swap two components on different pages, as long as you can see 
both at the same time. You would probably have to zoom out.

Switching the positions of 
two components is a simple 
drag-and-drop action.
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To switch the positions of two components, do the following:

1. Open ProShares-Vanguard.

2. In the Navigation pane, scroll down and click page 9.

Click here to display page 9.
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On page 9, you see the Holdings-Based Style Map and Holdings-Based Style Trail near 
the top of the page, and the Returns-Based Style Map and Returns-Based Style 
Allocation at the bottom. If the Holdings-Based Style Trail chart and the Returns-Based 
Style Map switch places, the Holdings-Based components will be displayed on the left 
and the returns-based components on the right.

3. Click the Holdings-Based Style Trail chart to select it.

Holdings-based charts

Returns-based charts

When a component is 
selected, it displays a 
blue border.
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4. Drag the Holdings-Based Style Trail chart to the cell occupied by Returns-Based Style 
Map. The two components switch places.

5. To save your work, click the Application Settings icon at the top-left corner of the 
window and select Save.

The two 
components have 
switched places.

Be sure to save frequently.
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Exercise 11:   Delete 
a component

You might decide an existing component is not particularly relevant to your 
presentation, or you might have another reason for deleting it.

To delete a component, do the following:

1. In ProShares-Vanguard, in the Navigation pane, scroll down and click page 12 (the 
last page).

2. Select the Estimated Net Flow $Mil (Month-End) table. 

3. Right-click and select Delete. 

A confirmation alert opens.

Click anywhere in the 
table’s cell to select it.

The options displayed on the 
menu change, depending on 
what is selected. 

You must click Yes in the 
confirmation alert to delete 
the selected component.
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4. In the confirmation alert, click Yes. The component is deleted, but the cell it occupied is 
still selected. 

Go to the next exercise, Exercise 12 on page 60, to learn how to remove the empty cell.

Note the blue border 
on the selected cell.
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Exercise 12:   Remove 
a cell

Although you deleted the component below the Estimated Net Flow (Month-End) 
chart, the chart did not resize to fill the available space. Allocating the space to 
the Estimated Net Flow (Month-End) chart requires you to remove the empty cell and 
then resize the Estimated Net Flow (Month-End) chart’s cell.

Do the following:

1. In ProShares-Vanguard, select the empty cell.

2. Right-click and select Delete.

The selected cell is 
outlined in blue.
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When the empty cell is removed, the component above it (Estimated Net Flow 
(Month-End)) resizes to use that area. 

3. To save your work, click the Application Settings icon at the top-left corner of the 
window and select Save.

The chart now 
occupies the 
full page area.

Be sure to save frequently.



Presentation Studio September 2018 62
© 2018 Morningstar. All Rights Reserved.

Using Workbook Settings and Component Settings Overview

Using Workbook Settings and Component Settings

OverviewIn What can I do in the Application Settings? on page 16, you learned how to select 
features to be used in all the reports you create from that point on. In this section, you 
will learn how to select features that affect only a specific report or component. You 
will learn how to modify and create time periods.

Before starting the exercises, you might want to review How do Application, 
Workbook, and Component Settings relate to each other? on page 19.

This section helps you do the following:

gunderstand what Workbook Settings are (page 62)
gunderstand your options when changing a time period (page 63)
gunderstand the Start Date and End Date selections (page 64)
gmodify the Start Date and End Date for a report (page 66)
gunderstand what Component Settings are (page 69)
gmodify the Start Date and End Date for a component (page 69)
gunderstand what a linked time period is (page 72)
g create multiple time periods (page 73), and
g apply a time period (page 75), and
g reset a time period (page 77).

What are 
Workbook Settings?

Workbook Settings are options specific to a single report. These options can affect 
various aspects of the report, including the following:

g fonts
g colors
gdata
gpeer group, and
g time period.
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What do I 
need to know before 
changing a time period?

The time period (Start Date and End Date) is one of the features you can change in 
either Workbook Settings or Component Settings. Before selecting a different time 
period, you should understand the following:

g The time period initially used in your report is determined by the settings in the 
template (or report) your report is based on.

gYou can modify the time period for your report or for individual components, and
gYou have two options on how to change the report’s default time period and two 

options on how to change a component’s time period.

Changing the time period for a report or a component is summarized in this table:

When changing the time 
period for this…

Using Start Date and End Date selections 
here… The result is…

Report

 Note: Selecting a component 
is optional.

Command bar…Home tab…
Workbook icon…Workbook Settings: 
Data window

The default time period is changed for the 
report. All components, both existing and 
yet-to-be created, are affected. See 
Exercise 13 on page 66.

 Note: Individual components with a 
non-default time period are not affected.

Command bar…Chart or Data Table 
tab…Application Settings icon (next to the 
Time Period drop-down field)…
Default Period

A selected chart or table Command bar…Chart or Data Table tab The time period is changed for only the 
selected component. Other existing 
components and new components you 
create are not affected. See Exercise 14 on 
page 69.

 Note: The selected component will not be 
affected if you change the report’s default 
time period.
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What are the start 
and end date selections?

The Start and End Dates can be set in Application Settings, Workbook Settings, and 
Component Settings.

In the Start Date drop-down field, the selections at the top range from one day to 20 
years ago. You can also enter a date. However, the drop-down field also offers flexible 
selections for dates associated with specific content or events, such as the following:

g investment(s) in the report or component,
gbenchmark used in the report or component, or
g return date
g inception date, or
gwhen the report is updated.

 Note: In any component with start and end dates, when a Common Inception option is 
selected as the Start Date, the common inception date is displayed in the legend.

The selections in the End Date drop-down field are event- or time-bound, except for 
Common Return End Date (at the bottom of the drop-down field), which is determined 
by the investments in the report.

In these selections, you 
can include or exclude 
the benchmark.

These dates are determined by 
the report date.

Event-bound options

Time-bound options

Time-bound options
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Note that some of the selections can be expanded. In the selection shown here, the 
end date is three months ago month end:

Certain components offer additional date options. See the following:

gHow can I compare funds’ holdings using their most recent common portfolio date? 
on page 141

gHow does the portfolio date affect the end date in a stacked bar chart? on 
page 143, and

gHow does the portfolio date affect the end date in a stacked bar chart? on 
page 143.

Click the caret to show 
additional selections.
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Exercise 13:   Change the 
time period for a report

Before starting this exercise, you might want to review What do I need to know before 
changing a time period? on page 63.

To modify the time period for a report, do the following:

1. In the ProShares-Vanguard navigation pane, click page 1. 

On page 1, in the Investment Growth chart and Performance table, notice that the time 
periods match. This time period was initially defined in the template on which the report 
is based.

Both components reflect the 
same five-year time period.
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2. On the Command bar, select the Home tab, then click the Workbook icon. The 
Workbook Settings: Data window opens.

 Note: If you are working in a factsheet, the icon on the Home tab is still labeled Workbook.

3. From the Start Date drop-down field, select an 1 Year ago.

4. From the End Date drop-down field, select Last Quarter End. 

5. Click OK. The Workbook Settings window closes. You have changed the default for 
the report. 

When the Workbook 
Settings window 
first opens, the Data 
tab is selected.

Note the settings 
for Start Date and 
End Date.
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Note that the time period in both the chart and table on page 1 have changed. This is 
true throughout the workbook because each component’s time period is linked to the 
report’s default time period.

6. Select any component and at the top of the window, select the Chart or Data Table tab. 
The information in the Time Period portion of the selected tab tells you the following:

g the start and end dates for the selected component, and
g if the selected component uses the report’s default time period.

Both components reflect 
the new default time 

The selected component 
reflects the report’s 
default time period.
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What are 
Component Settings?

Component Settings are options specific to a single component These options can 
affect various aspects of the report, including the following:

g fonts
g colors
gdata
gpeer group, and
g time period.

 Note: In Component Settings, you can change many of the same things you can in Workbook 
Settings, but only the selected component is affected.

Before going on to the exercise, you might want to review the information in What do I 
need to know before changing a time period? on page 63

Exercise 14:   Change 
the time period 
in a component

Before starting this exercise, you might want to review What do I need to know before 
changing a time period? on page 63.

When you modify the settings of an individual component (such as a chart or 
table), the new settings override the Application and Workbook Settings, but only for 
that component.

To modify the time period of an individual component, do the following:

1. With ProShares-Vanguard open, select the Investment Growth chart at the top of 
the first page. 

The time period 
reflects the 
default.
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2. On the Command bar, select the Chart tab.

3. From the Start Date drop-down field, select 6 months ago.

4. From the End Date drop-down field, select Last Month End. 

Note that the Time Period 
displays Default Period. 

If the report includes 
other predefined 
Time Periods, you 
could select one of 
them from here.
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The new dates affect only the selected component. The other components in the report 
are unchanged.

5. With the Investment Growth chart still selected, select the Home tab, then select the 
Chart tab. The information in the Time Period portion of the selected tab tells you 
the following:

g the time period for the selected component, and
g if that time period matches the report’s default time period. In this case, the Time 

Period indicates “Locked,” which means the component doesn’t use the default 
time period.

Time period specific to 
this component

Default time period from 
the Workbook settings

Locked is displayed 
when the selected 
component’s time 
period does not match 
the report default.



Presentation Studio September 2018 72
© 2018 Morningstar. All Rights Reserved.

Using Workbook Settings and Component Settings What is a linked time period?

6. To save your work, click the Application Settings icon at the top-left corner of the 
window and select Save.

What is a 
linked time period?

Initially, a component’s time period is the same as the time period in Workbook 
Settings. The component’s time period is linked to the report’s time period. If you 
change the report’s time period in Workbook Settings, that change is reflected in the 
linked time periods of components.

When you change a component’s time period (as described in Exercise 14: Change 
the time period in a component on page 69), the link becomes inactive. An inactive link 
is not affected if you change the time period in Workbook Settings.

You have been working with linked time periods in Exercise 13: Change the time period 
for a report on page 66 and Exercise 14: Change the time period in a component on 
page 69.

Be sure to save your work frequently.
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Exercise 15:   Create 
multiple time periods

In this exercise, you will create additional time periods, allowing you to change the 
time periods for all components and pages in a report without modifying each 
component individually. Keep the following in mind when working with multiple 
time periods:

gYou can create up to eight additional time periods.
g The time periods are available if you need them but are not necessarily in use in 

the report at any given time, and
g The time periods are specific to the report (or template) in which they are created.

 Note: When you create time periods as described in this exercise, those time periods are 
available in all components in the report.

To create additional time periods, do the following:

1. In ProShares-Vanguard, click the Home tab, then click Workbook. The Workbook 
Settings Data window opens. 

2. Click the Time Periods icon to the right of the End Date drop-down field. The Time 
Periods dialog box opens. 

Click Workbook to create a new 
workbook from scratch.

Clicking a gear icon opens 
a related custom settings 
dialog box or window.
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3. From the drop-down fields, select a Start Date and an End Date for at least one 
time period.

 Note: If you are building a template, keep in mind that all time periods are enabled, which 
means anyone who uses the template can select from all nine time periods. If you want users 
to select from specific time periods (for example, the first six), you may want to name the other 
time periods “Do Not Use.”

4. In the Name column, name the time period(s) you changed to indicate its range. For 
instance, the name 1YrAgo-LastQtrEnd describes its range.

5. Click OK.

6. In the Workbook Settings: Data window, click OK.

You can name any of the time 
periods, except the default

Click a calendar icon to open a 
calendar and select a date
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Exercise 16:   Apply a 
predefined time period 
to a chart

When working with a report in which additional time periods have been defined, you 
can switch from the default time period to one of the predefined time periods for a 
specific chart. 

Do the following:

1. In ProShares-Vanguard, on page 9, select the Returns-Based Style Allocation chart. On 
the Command bar, the Chart tab is now selected.

The selected chart displays 
a blue border.

The time period of the 
selected chart is displayed 
on the Chart tab.
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2. On the Chart tab, from the Time Period drop-down field, select a modified, renamed 
time period. The report refreshes to reflect the selected time period in the chart and on 
the Chart tab (when the chart is selected). 

 If you select Locked and 
later change the Default 
Period, the locked 
component will not change 
to the new default.

The time period information for 
the selected chart is displayed 
at the top of the window.
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Exercise 17:   Reset a 
chart’s time period 
to the default

When you created additional time periods in Exercise 15 on page 73, you might have 
noticed that the default time period was listed in the Time Periods dialog box. It is also 
listed on the Time Period drop-down field. These settings make it easy to reset a chart’s 
time period to the default at any time.

To reset a chart’s time period to the default, do the following:

1. In ProShares-Vanguard, on page 9, select the Returns-Based Style Allocation chart. On 
the Command bar, the Chart tab is now selected.

The selected chart displays 
a blue border.

The time period of the 
selected chart is displayed 
on the Chart tab.
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2. On the Chart tab, from the Time Period drop-down field, select Default Period. The 
report refreshes to reflect the new time period in the chart and on the Chart tab (when 
the chart is selected). 

Remember—if you have changed the time period in Workbook Settings, that is the 
new default for the component.

How can I learn more 
about customizing 
components?

In this section, you have learned how to customize the properties of individual 
components. As you become more familiar with Presentation Studio, you will see 
customizations that are common to most components, such as clicking the Eye icon to 
show or hide certain data. 

Additionally, in most components, when you click Chart Settings or Table Settings, you 
can do the following:

g select a different benchmark
g select a different currency, and
g change, add, and delete data points.

However, some components have uncommon features to help you display additional 
information. To learn about these components and their settings, please read Using 
Components with Nonstandard Features on page 135.

 If you select Locked 
and later change the 
Default Period, the 
locked component 
will not change to 
the new default.
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Creating a New Page

OverviewYou can add a new page anywhere in a report.

This section guides you as you do the following:

g add a page to a report (page 79)
g create a page layout (page 80)
guse Snap to Grid to precisely resize a cell (page 83), and
g insert a component into a cell (page 84).

Exercise 18:   Create 
a new page

When you add a page to a report, you can choose to duplicate an existing page or 
create a blank page. The new page appears after the page selected in the 
Navigation pane.

To add a new blank page to the end of a report, do the following:

1. In the Navigation pane of ProShares-Vanguard, scroll to the bottom and click the last 
page to select it.

The selected page is outlined in blue.

Drag the scroll bar to move up and 
down in the Navigation pane.
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2. On the Command bar, select the Home tab.

3. Click the Page icon and select New. A new page is created after the page selected in 
the Navigation pane (in this case, the last page).

Exercise 19:   Create 
the page layout

The newly created page consists of one large cell, which is fine if you want to use a 
large component or a table component requiring a full page. But in most cases, you 
want the page to contain multiple cells.

Do the following:

1. On the Home tab, click the Divide Page icon and select the right Two Cell option.

If you select Duplicate, a copy 
of the selected page is created.

The Two Cell 
options divide the 
page into two cells 
of equal width.
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The page is now divided into two cells. 

2. With the top cell selected, on the Home tab, click the Divide Page icon and select the 
left Two Cell option.

Note that the top 
cell is selected.

This option divides the 
selected cell into two 
side-by-side cells of 
equal width.
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The top cell is now divided into two cells.

 Note: The cells do not have to remain equal in size. You can resize them as you did earlier in 
Resize a cell on page 51.

3. To save your work, click the Application Settings icon at the top-left corner of the 
window and select Save.

You might need to click each 
cell to see the two cells.

Be sure to save frequently.
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Exercise 20:   Use Snap 
to Grid to precisely resize 
a cell

In the blank page, the two cells at the top are the same width (3.75"). However, the 
design calls for the left cell to be 2.75".

You can resize cells by dragging the margin and cell borders, but even with the ruler 
and gridlines visible, it can be difficult to set an exact measurement, such as 0.75". 
Snap to Grid makes it simple to precisely resize and position cells. 

To enable Snap to Grid, do the following:

1. On the Home tab, click View, then from the menu, select Snap to Grid.

2. If Ruler is not already selected, select Ruler.

3. On the page, hover your cursor over the vertical border between the two top cells. The 
cursor changes to a double-sided arrow.

4. Drag the cursor to the left while watching the position numbers displayed just below 
the ruler.

5. When the position number is close to 3.25", release the cursor.

6. Hover the cursor over the border once more and notice that, even though you may have 
released the cursor somewhere between 3.23" or 3.27", the new position is 3.25".

You can also display or hide 
the gridlines.

The current position 
is displayed just 
below the ruler.

The position number changes 
as you move the cursor.

If the position displays a different value (perhaps 3.20 or 3.30), 
you released the cursor when it was closer to that position.
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Exercise 21:   Insert a 
component into a cell

Inserting a component into a cell is the same process as replacing a component—
drag-and-drop.

Do the following:

1. With ProShares-Vanguard open and the last page displayed, make sure the Home 
tab selected.

2. Select Chart…Markets and drag Market Trailing Returns Bar Chart into the empty 
cell in the upper-left corner. 

Note the 
highlighted 
selections.

The chart occupies 
the top-left cell.
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3. With the Home tab selected, select Table…Performance, then drag Morningstar 
Category Ranks into the bottom cell.

The page should now look like this.

 Note: You will Insert an image into the top-right cell in Exercise 27 on page 100.

Note the 
highlighted 
selections.

The page has two 
components.
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4. To save your work, click the Application Settings icon at the top-left corner of the 
window and select Save.

Be sure to save frequently.
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Customizing a Component

OverviewEach component allows a certain amount of customization. When you modify (or 
customize) a setting of an individual component, that setting overrides Application 
Settings and Workbook Settings, but for that component only. 

You have learned how to modify a component’s start and end dates from the Command 
bar (Change the time period in a component on page 69), but many other aspects of a 
component’s look and content can be customized by using the Component Settings. 

Before starting this section, you might want to review How do Application, Workbook, 
and Component Settings relate to each other? on page 19.

This section describes using Component Settings to do the following:

g customize a bar chart by hiding values and changing the orientation (page 87)
g customize a table by changing the portfolio date and removing a row (page 90)
g add a data point to a table component (page 92), and 
g change a data point in a table component (page 94).

Exercise 22:   Customize 
a bar chart

A chart is a graphic representation of data. You have seen how you can modify that 
representation by resizing a chart to make it more readable or make the page more 
presentable. You have modified the represented time period to focus on specific 
data. Color, marker shapes, and line widths are some of the other graphic properties 
you can use to enhance a chart. These and other options are found in the 
Component Settings.

Do the following:

1. In ProShares-Vanguard, go to page 10. 

2. Select the Multiple Investment Sector Exposure chart.
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3. At the bottom of the window, click Chart Settings. The Chart Settings window opens.

4. In the Chart Settings window, next to Values, click the Eye icon. 

 Note: The various chart types have different options in the Chart Settings window.

The Component Settings button 
displays “Chart Settings” or “Table 
Settings,” depending on the type of 
component you have selected.

Notice the values above 
each of the vertical bars.

The Eye icon is available in many settings, 
allowing you to display or hide a variety 
of features.

If the Chart Settings window obscures 
your view of the chart, drag here to 
move the window, but do not click the X.
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In the chart, the numbers above each bar are no longer displayed.

5. In the Chart Settings window, from the Orientation drop-down field, select 
Horizontal Bar.

The new setting takes 
effect immediately; the 
Component Settings 
window does not have 
buttons for Apply or OK.

The default orientation for 
this chart is vertical bar.
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The chart now looks like this.

6. To close the Chart Settings window, do one of the following:

g In the upper-right corner of the Chart Settings window, click the X, or 
g Click away from the Chart Settings window.

Exercise 23:   Customize 
a table

Customizing a table is similar to customizing a chart, however a table offers 
different options.

Do the following:

1. In ProShares-Vanguard, on page 10, select the Equity Sectors table. 

 Note: The funds do not report portfolio numbers on the same date, which is why the dates in 
the Portfolio Date column do not match.

2. At the bottom of the window, click the Table Settings button. The Table Settings 
window opens.

If the space 
available and/or 
number of 
investments make 
the selected 
orientation 
unappealing, 
simply select the 
Vertical option.

The Component Settings 
button now displays 
“Table Settings.”

Note the portfolio 
dates do not match.
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3. From the Portfolio Date drop-down field, select Last Year End.

 Note: You might need to move the Table Settings window to see the Equity Sectors table.

Note the following changes to the table:
g The data shown in the columns now reflect the portfolio date you selected.
g The Portfolio Date is now displayed above the table, and
g The Portfolio Date column has been removed.

4. To save your work, click the Application Settings icon at the top-left corner of the 
window and select Save.

The default Portfolio Date for this 
table is Most Recent Portfolio.

Note that you can hide the 
Table Title and Portfolio Date.

The new portfolio 
date affected several 
features in the table.

Be sure to save frequently.
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Exercise 24:   Add a 
data point to a table

In a table or chart, you can add, remove, or replace data points. In this exercise, you 
will do the following:

g add a page
g insert a table component, and
g add a data point to the table.

 Note: You may want to review Exercise 18: Create a new page on page 79, Exercise 19: Create 
the page layout on page 80, and Exercise 21: Insert a component into a cell on page 84.

Do the following:

1. In ProShares-Vanguard, create a new page at the end of the report.

2. Select a three-cell page layout as shown here.

3. In the top cell, insert a Multiple Investment Snapshot table.

Note the 
highlighted 
selections.

Note the 
highlighted 
selections.
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4. In the table, right-click the Inception Date column header, and from the drop-down 
field, select Insert Column.

 Note: When you click or right-click a column header, drop-down fields appear above each 
column.

A new column appears to the right of the Inception Date column. It is currently labeled 
Morningstar Rating Overall.

Right-click in 
this area…

…then select 
Insert Column.



Presentation Studio September 2018 94
© 2018 Morningstar. All Rights Reserved.

Customizing a Component Exercise 25:   Change a data point

Exercise 25:   Change a 
data point

As you saw in the previous exercise, when you create a new column, it defaults to 
Morningstar Rating Overall. In this exercise, you will select a different data point for 
that column.

 Note: This procedure can be used for any column. It is not restricted to columns you create.

Do the following:

1. If the drop-down field is not visible above the column heading Morningstar Rating 
Overall, click the column heading.

 Note: When you click or right-click a column header, drop-down fields appear above each 
column.

2. Click the drop-down field above the column header (Morningstar Rating Overall). The 
drop-down field opens.

The options in this drop-down field are similar to those you see throughout Morningstar 
Direct, whenever you search for a data point to use. You can select from the following 
fields to find the data point you want:
g Universe (Open End Funds in the above illustration)
g Location (General in the above illustration), and
g Find By (View or Contains).

When Find By View is selected (as in the above illustration), the data points found in 
the selected View (Snapshot in the above illustration) are displayed.

When Find By Contains is selected, the View drop-down field is replaced by a 
Search field.

Click here to 
select a different 
data point for 
this column.
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3. In the list of data points, select Investment Area, click Add, then click Close.

4. The column header now reads Investment Area and the column displays 
that information.

Select this data point.

Note the highlighted selections.
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Working with Headers, Footers, Images, and Watermarks

OverviewImages can be an important part of your presentation. For instance, a company logo 
reinforces your company’s branding. Many graphic formats, such as .jpg, .png, and so 
on, are compatible with Presentation Studio.

A header is an area for information at the top of a page (company name, logo, and so 
on) and a footer is displayed at the bottom of a page (page number, source of data, and 
so on). In Presentation Studio, a report can have the same header and footer on every 
page, or individual pages can vary.

This section describes how to do the following:

gunderstand what content to include in a header or footer (page 96)
g add a header (page 98)
g insert an image into the header (page 100)
g change the position of an image (page 102)
gunderstand what dynamic text is (page 103)
guse dynamic text in the header (page 103)
g change font properties (page 104)
guse the same header on every page of a report (page 105)
g change the size of an image in a body cell (page 107), and
g add a watermark (page 111).

 Note: In this section, working with a header is described. The process for creating and 
working with a footer is the same.

What content 
should I include 
in a header and footer?

Header and footer content does not have any hard-and-fast rules (although your firm’s 
legal and design teams might). Some common elements used in header and footers are 
as follows:

gYour company logo
gYour company name
gClient name
gReport type
gReport date, and
gPage number.

The information in a header and/or footer can apply to the entire report or selected 
pages. Some common header and footer page layouts are as follows:

g The same header and footer are displayed on every page.
gAll pages have the same header and none have a footer, and
g The header and/or footer content on pages 2 to the end differs from that on the 

first page.
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In the illustrations here, note the headers and footers, where they match on both 
pages, and where they differ.

On the first page, 
the header 
displays the type 
of report and a 
company logo.

On the second 
page, the header 
matches the 
header on page 1.

The first page 
does not have 
a footer.

The second page 
has a footer in 
which the page 
number and page 
count are displayed.
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Exercise 26:   Add 
a header to a page

The page you created in ProShares-Vanguard currently has no header, but the other 
pages do. In this exercise, as you add a header to the page, keep in mind that you can 
add a header and footer to any page, or replace components in any existing header 
and footer.

To add a header, do the following.

1. With ProShares-Vanguard open, in the Navigation pane, scroll to the bottom and select 
the last page. (This is the page you created in Creating a New Page on page 79).

2. On the Command bar, select the Format…Header icon, then select Insert Header. 

In the Navigation 
pane, the selected 
page is outlined 
in blue.

The other selections on the Header menu become available 
after you have inserted a header.
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A new cell opens at the top of the page.

3. With the header cell selected, on the Command bar, make sure the Format tab is still 
selected, then click the Divide Page icon and select the Two Cell option showing 
side-by-side cells.

4. In the header, allocate more space to the left cell and less space to the right. Select the 
left cell and drag its right border to the 6.5" mark on the ruler (approximately).

To make room for the header, 
space was removed from the 
two rows of cells.

With two cells 
in the header, 
you can have 
two components 
in the header.

You can use the 
ruler as a guide 
when you move 
a border.
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5. To save your work, click the Application Settings icon at the top-left corner of the 
window and select Save.

Exercise 27:   Add 
an image

In this exercise, you should use an image available on your network or drive. 

 Note: Although the logo is being added to the header, the process described here can be used 
to add an image to any cell.

To add a logo, do the following: 

1. In ProShares-Vanguard, in the header, select the right cell.

2. On the Command bar, select the Format tab, then click Image…Insert Image. The Open 
dialog box opens.

Be sure to save frequently.

Note the highlighted selections.
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3. In the Open dialog box, navigate to a location on your network or drive and double-click 
an image file.

The image is displayed in the header cell. 

 Double-click here 
to insert this image.

By default, the 
image is centered 
in the cell.
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Exercise 28:   Change the 
position of an image

When you insert an image, it is centered in the cell. 

To change the image’s position, do the following:

1. Select the cell containing the image.

2. On the Command bar, select the Format tab, then click Align…Right. 

The image aligns with the right side of the header cell.

3. To save your work, click the Application Settings icon at the top-left corner of the 
window and select Save.

.

You can select one option 
from each section of the Align 
menu; the top four selections 
position the component 
horizontally, and the bottom 
three selections position it 
vertically.

The size of the 
image does 
not change.

Be sure to save frequently.
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What is dynamic text?Dynamic text displays information (such as investment name, ticker, and so on) specific 
to a report or investment. Dynamic text updates automatically whenever the report is 
opened or refreshed. For instance, if a report displays the dynamic text component 
Report Date, the new report date is displayed when you open the report. 

 Note: If you do not want to keep the updated Report Date, close the report without saving.

Exercise 29:   Use dynamic 
text in a header

In this exercise, use the dynamic text component “Workbook Name” in a header. The 
header then reflects the name of the report.

 Note: You can type text in a cell but it won’t be dynamic.

Do the following: 

1. In ProShares-Vanguard, in the last page’s header, select the left cell.

 Note: Because a cell cannot accommodate more than one component, the text and image 
must be in separate cells.

2. On the Command bar, select the Format tab, then click Text…Dynamic 
Text…Workbook Name. 

Note the 
highlighted 
selections.
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The workbook name is displayed in the header.

Exercise 30:   Change 
font properties

You can change font properties of a text component (whether dynamic or not) from the 
Command bar. Some of the font properties are as follows:

g Font family (Times Roman, Helvetica, and so on)
g Font size, and
g Font style (bold, italic, and underlining).

Do the following

1. In ProShares-Vanguard, with the Format tab and the left header cell selected, from the 
Font Size drop-down field, select 24. 

The header should now look something like this.

The text defaults 
to left and top 
alignment; the 
font and font size 
match the report 
font defaults.

You can also select a different 
font family and apply bold, italic, 
or underlining.

Your header 
displays the image 
you selected.
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2. To save your work, click the Application Settings icon at the top-left corner of the 
window and select Save.

Exercise 31:   Use 
the same header 
throughout the report

You do not have to recreate the header on every page; you can easily share it across all 
pages in the report.

Do the following:

1. In ProShares-Vanguard, in the Navigation pane, click a few pages to view them. Note 
that, except for the page you created, they all display the original header from the 
template.

2. Go to the last page (the page you created) and select a cell in the header.

Be sure to save frequently.

This is the header from 
the Equity Manager 
Analysis template.
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3. On the Command bar, select the Format tab, then click Header…Apply Header 
to Workbook.

4. In the Navigation pane, click a few pages to view them. Now they all display the header 
you built.

Be sure a cell in the header 
you want to use on all 
pages is selected.

When applied to the Workbook, 
the header does not change 
from page to page.
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5. To save your work, click the Application Settings icon at the top-left corner of the 
window and select Save.

Exercise 32:   Change 
the size of an image

When working with an image, keep the following in mind:

gWhen you insert an image into a header or footer cell, it resizes to fit the cell 
without distorting the proportions; and

gWhen you insert an image into a regular (body) cell, it does not resize to fit the cell, 
which means it might be too large or small for the selected cell.

In this exercise, inserting an image into a body cell and changing its size is described.

Do the following:

1. In ProShares-Vanguard, on the last page in the top row, select the right (empty) cell.

2. On the Command bar, select the Format tab, then click Image…Insert Image. The 
Open dialog box opens.

Be sure to save frequently.

Note the highlighted selections.
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3. Navigate to a location on your network or drive, and double-click an image file. The 
image is inserted into the selected cell. The cell remains selected.

The selected image appears in the cell.

 Double-click an 
image file to insert it 
into the selected cell.

The image is centered in the 
cell and does not change size.
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4. With the right cell still selected, right-click and select Position…Fit.

The image resizes proportionally to fit in the cell.

Note the highlighted selections.

When resized proportionally, 
the image might not fill the cell.
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5. With the cell still selected, right-click and select Position…Stretch. 

The image resizes to fill the cell, but loses its original proportions.

Note the highlighted selections.

Note the distortion in the image.
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6. To save your work, click the Application Settings icon at the top-left corner of the 
window and select Save.

Exercise 33:   Add 
a watermark to a report

You can add a watermark to a report. The watermark appears in the PDF generated 
from the report. This feature is useful when a report has restricted distribution, such as 
“Internal Only.”

To add a watermark, do the following:

1. In a report, select the Home tab, then click Workbook. The Workbook Settings 
window opens.

2. Select the Layout tab.

3. Click the Display Watermark in PDF checkbox.

4. In the text field to the right of the checkbox, type the watermark text. 

 Note: The maximum number of characters is 50, including spaces.

Be sure to save frequently.
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5. (Optional) From the drop-down field to the right of the text field, select a color.

6. Click OK. The watermark text is not displayed in the report.

7. At the top of the window, on the Home tab, click PDF. The PDF menu opens. Select an 
output option. In this example, Full Report is selected.

These settings control the text 
and color of the watermark

Select any 
option on the 
drop-down field
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When the PDF has finished generating, it opens.

The watermark text is 
displayed on every page
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Creating a Template

OverviewUp to this point, you have worked with Morningstar templates, but they are not your 
only options. You can also create your own templates. 

In this section, the basics of creating a template are described as follows:

gwhat is involved in creating a template (page 114)
ghow to save a report as a template (page 116), and
ghow to create a portfolio template (page 119).

What is involved in 
creating a template?

To create a template, first identify the purpose of the template and then create a report 
to present the appropriate data. Once you are satisfied with the report, you save it as 
a template.

You can also create a template starting from an empty file or, if you have an existing 
template or report with similarities to the template you want to build (in content and/or 
layout), you might want to base the new report on that. 

In this guide, most of the tasks necessary for building a template have been covered. If 
you have followed the steps, you have completed the tasks described in the table here.

Task Click to review the topic

Created a report based on an existing template Working with a Template on page 24

Replaced, removed, rearranged, deleted, and 
resized components 

Working with Chart and Table 
Components on page 40

Set a time period for the report Using Workbook Settings and Component 
Settings on page 62

Created a new page with a custom layout and 
inserted components in cells

Creating a New Page on page 79

Customized individual components using Chart 
and Table Settings

Working with Chart and Table 
Components on page 40

Added a header and inserted an image and 
dynamic text

Working with Headers, Footers, Images, 
and Watermarks on page 96
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Before saving a report (such as ProShares-Vanguard) as a template, you should do 
the following:

1. (Optional) Insert a footer. Consider including dynamic text, such as a page number and 
your firm name.

 Note: The steps for creating a footer are the same as those for creating a header. See Add 
a header to a page on page 98 and in steps 2 and 3, click the Footer icon and select 
Insert Footer.

2. Review the content on all pages to make sure the purpose of the template is supported 
throughout the report. Some of the questions you should ask yourself include 
the following: 

g Is every component relevant to the purpose of the template? 
g Is the order and position of components appropriate to the purpose of the template?
g Are similar components (such as a chart and a table displaying holdings-based data) 

displayed on the same page?
g Is every page easy to read?
g Are text, table, and chart components easy to interpret?
g Are more pages needed?
g Can you delete any pages?
g Where can you use dynamic text to make the template as flexible as possible? For 

instance, if regular (typed) text is used, it is shown in every report based on the 
template, so make sure you have not keyed in the names of the firm, benchmarks, 
indexes, and so on 

g Is every component and page appropriately labeled? For instance, if every 
component on a page displays information about risk, it might not be necessary to 
show the label (or title) of every component.

g Does the report meet your firm’s branding and design standards? You might want 
to contact your Marketing or Design department to learn about preferred fonts 
and colors.

 Note: Do not assume a Morningstar template can be used without modification. If you need a 
template for Current Portfolio Analysis, the Morningstar Current Portfolio Analysis template is 
a good starting point, but do not skip the above review steps. At the least, you should remove 
or replace the Morningstar logo.

When creating a template, one thing you do not have to modify is the investment(s) 
you selected. The investment(s) are simply placeholders so you have a visual 
representation of your work. When you save the report as a template, the investments 
and related data related become irrelevant.

When you want to use a template as the basis of a new report, you open the template 
and you are immediately prompted to select investments. (See Select an investment on 
page 27 and Select investments from a saved list on page 35.) The sample investments 
in the report are replaced by the investments you selected and the report accesses the 
data related to the selected investments.
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Exercise 34:   Save a 
report as a template

When you are satisfied that your report is as template-ready as possible, save it as 
a template.

 Note: In this exercise, it is assumed that your ProShares-Vanguard is final, regardless of what 
condition it is in.

Do the following:

1. With ProShares-Vanguard open, in the upper-left corner of the window, click the 
Application Settings icon and select Save.

2. Click the Application Settings icon again, and select Save As Template. A dialog 
box opens.

Saving the report ensures its 
current condition is saved when 
you save it as a template.

Saving the report as a template 
creates a new file; the report is 
not affected.
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3. In the Template Name field, replace “ProShares-Vanguard” with Manager 
Analysis - Equity.

4. Click Save. An alert opens, reporting that the file has been successfully saved as 
a template.

5. Close the template. The Presentation Studio Home page is displayed.

6. On the Presentation Studio Home page, on the toggle, select My Templates.

The template is saved into 
the My Templates folder.

Click here to access 
your templates.
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Your templates are displayed in the list area.

What do I need to 
know before creating 
a portfolio template?

The two portfolio templates are as follows:

gPortfolio Proposal template, and
gPortfolios Comparison template.

In these templates, the features you have learned about (components, page layouts, 
headers and footers, and so on) are available, but they are not prebuilt in the 
templates. To create a portfolio template, you must build from scratch.

Do the following:

1. On the Presentation Studio home page, click the Portfolios tile. The Choose Template 
dialog box opens.

2. Click New Template. The Select a Template Type dialog box opens,

Your new template is displayed 
at the bottom of the list.

Click here to begin.

When you have created a 
portfolio templates, its 
name, owner, and template 
type are displayed here. It 
can then be used as the 
basis for a portfolio report.
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3. Select a template type, as follows:

g Use the Portfolio Proposal template to present a proposed portfolio to a client. Go 
to Exercise 35 on page 119.

g Use the Portfolios Comparison template, to compare multiple model portfolios. Go 
to Exercise  on page 120.

Exercise 35:   Create a 
Portfolio Proposal 
template

After completing the steps in What do I need to know before creating a portfolio template? 
on page 118, do the following:

1. In the Add Sample Portfolios dialog box, select the following:

g a client account, and
g one or more proposals.

The other fields in the dialog box are optional.

These templates contain 
components appropriate 
to portfolios.

A client account and 
at least one proposal 
are required.
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2. Click Done.

A blank Presentation Studio file opens.

The charts available in this template are as follows:
g Multiple Investment Growth
g Legend
g Returns Correlation Matrix
g Calendar Returns Bar Chart
g Rolling Window Chart
g Trailing Returns Bar Chart
g X/Y Scatter Plot
g Pie Chart
g Morningstar Style Box, and
g Multiple Sector Exposure Chart.

The tables available in this template are as follows:
g Multiple Investment Performance
g Multiple Investment Snapshot
g Multiple Investment Calendar Returns
g Multiple Investment Trailing Returns, and 
g Portfolio Holdings.

Continue creating the template, using the processes in this document and following 
the guidelines in What is involved in creating a template? on page 114.

Exercise 36:   Create a 
Portfolios Comparison 
template

After completing the steps in What do I need to know before creating a portfolio template? 
on page 118, do the following:

1. In the Add Portfolios dialog box, select two or more portfolios to compare.

2. Click Done. The Add Sample Portfolios dialog box opens.

When you select a portfolio, a 
checkmark is shown to its right.
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3. Selections in this dialog box are optional. Click Done.

A blank Presentation Studio file opens.

The charts available in this template are as follows:
g Multiple Investment Growth
g Legend
g Returns Correlation Matrix
g Calendar Returns Bar Chart
g Rolling Window Chart
g Trailing Returns Bar Chart
g X/Y Scatter Plot
g Pie Chart
g Morningstar Style Box, and
g Multiple Sector Exposure Chart.

The tables available in this template are as follows:
g Multiple Investment Performance
g Multiple Investment Snapshot
g Multiple Investment Calendar Returns
g Multiple Investment Trailing Returns, and 
g Portfolio Holdings.

Continue creating the template, using the processes in this document and following 
the guidelines in What is involved in creating a template? on page 114.

You can 
change the 
highlighted 
selections 
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Publishing a Presentation Studio Template

OverviewYou can publish a your Presentation Studio templates and use them when generating 
reports in the following Morningstar products:

gMorningstar Direct, and
gReport Portal.

The requirements for publishing a Presentation Studio template are as follows:

1. You must be the owner of the template. 

2. You cannot publish a Morningstar template. However, you can publish a template that 
you built based on a Morningstar template (or a template owned by someone else). See 
Exercise 38 on page 125.

3. You need permission to publish a Presentation Studio template. If you cannot complete 
the steps in Exercise 37 on page 123, contact your Customer Success Manager.

When you publish a template, you decide who may use the template. Be sure to 
include yourself (or a group of which you are a member) among those the template is 
published to.

In this section, you will learn how to do the following:

gpublish a Presentation Studio template (page 123), and
g save a copy of a Presentation Studio template you do not own (page 125).
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Exercise 37:   Publish 
a Presentation 
Studio template

Presentation Studio initially includes templates from Morningstar, which cannot be 
published to other users. Templates you create can be published to yourself, selected 
users, or all users at your firm. Do the following:

1. On the Morningstar Presentation Studio Home page, click My Templates.

2. Hover the cursor over the row displaying the name of the template you want to publish. 
The Action icon is displayed.

3. Click the Action icon and from the Action menu, select Publish To.

 Note: If Publish To is not an option on the Action menu, you do not have permission to publish 
templates. Contact your Customer Success Manager.

Click here to access 
your templates.

Note the highlighted selections.
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4. Click in the Search for User or Group field. A list of your firm’s Presentation Studio users 
is displayed. Do one or more of the following:

g Enter your email and select it (recommended).
g Search for the emails of the users who should have access to this template; be sure 

to select them.
g Select users from the list, and/or 
g Click All Firm Users to publish the template firm-wide.

5. Click OK, then click Done. An alert opens. 

6. Click OK.

7. In the list of your templates, note the template(s) you have published.

In Morningstar Report Portal, you can use your published templates to create reports. 
To learn about using Report Portal, read the Morningstar Report Portal User Guide.

Click in this field to make the 
Individual Users list appear.

You might need to 
scroll right to see the 
Published column.

https://morningstardirect.morningstar.com/clientcomm/Report-Portal-User-Guide.pdf
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or another user

Exercise 38:   Create a 
copy of a template 
owned by Morningstar 
or another user

If you built a template based on a Morningstar template or one built by another user, 
when you saved it, you became the owner. If you need to publish a Morningstar 
template or one built by another user, simply save a copy of it. You do not have to make 
any changes to the original template to own a copy.

 Note: Morningstar or the other individual is still the owner of the original.

Do the following:

1. Open a template you do not own.

2. Optional: Customize the template.

3. At the top-left corner of the window, click the Application Settings icon and from 
the menu, select Save As Template. A dialog box opens. 

4. In the Name field, type a name, then click Save. 

A copy of the template is created as a new template (with the name you entered). 
The original template is unchanged. The template you saved is stored in the My 
Templates folder and listed on the Presentation Studio Home Page when My Templates 
is selected on the toggle.

5. Publish your template, as directed in Exercise 37 on page 123.

Note the highlighted selections.
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Creating a Batch Report

OverviewSuppose you need a monthly report on certain investments on the 16th day of the 
month. Every month, you could create each individual report by doing the following:

1. Open a template.

2. Select the investment(s) to be reflected in the report. 

3. Save the report.

4. Repeat steps 1–3 for each investment or set of investments.

It is more efficient to have it created automatically every month at a specific date and 
time. The automated process is called a batch report.

 Note: Batch reporting is not automatically enabled in user accounts. To gain access to batch 
reporting, contact your Customer Service Consultant.

In the Morningstar Report Portal, you can use your published templates to create 
reports. To learn about using Report Portal, read the Morningstar Report Portal 
User Guide.

In this section, the following procedures are described:

gunderstanding the process for generating reports in a batch (page 126)
g creating a batch report (page 127)
g testing a batch report (page 131), and
gdownload all reports from a batch (page 133).

What is the process 
for generating 
reports in a batch?

The overall process of creating a batch report is as follows: 

1. Select a template.

2. Select an investment or set of investments for each individual report.

3. Schedule the batch to run.

4. Test the batch.

The advantage to this over creating individual reports every month is that you don’t 
have to repeat this process.

In these exercises, the procedure to create a batch report for multiple investments is 
described, but you can also create a batch to generate a single report on a set 
of investments.

 Note: When preparing to create a batch report, keep in mind that a single-investment 
template can cover only one investment. In this guide, you used a single-investment template 
to create a factsheet. A multiple-investment template covers (and frequently compares) 
multiple investments. You used a multiple-investment template to create a workbook.

https://morningstardirect.morningstar.com/clientcomm/Report-Portal-User-Guide.pdf
https://morningstardirect.morningstar.com/clientcomm/Report-Portal-User-Guide.pdf
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Exercise 39:   Create 
a batch

In this exercise, create a batch to generate monthly ETF Analysis reports for 
several ETFs. 

 Note: If you don’t have an investment list or saved search of ETFs, use another investment 
type and an appropriate template.

Do the following:

1. On the Presentation Studio Home page, click Batch Management. The Batch Reporting 
window opens.

2. Select the Batch Management tab and click New Batch. The New Batch Setup dialog 
box opens.

3. Select Factsheet and click Continue. The New Batch Setup dialog box opens.

Click here to 
create a new 
batch or manage 
an existing one.

Note the 
highlighted 
selections.

You can use only one report type 
(Factsheet, Workbook, and so on) 
when creating a batch.
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4. Select Use a single template and click Continue. The Factsheet - New Batch Setup 
dialog box opens.

5. Do the following: 

g In the Batch Name field, enter Monthly ETF Analysis, and
g From the Template drop-down field, click Morningstar Templates, then scroll 

down and select Morningstar ETF Analysis. 

6. In the List/Search drop-down field, expand Lists and select a list of ETFs (in this case, 
5* Lg Blend ETF US).

When you use an investment list in setting up a batch report, the reports respond 
dynamically to changes to the list. In other words, when you make changes to the 
investment list, the changes are reflected in the reports the next time the batch runs.

The template you select is used 
for every report in the batch.

You do not have to use a 
Morningstar template to 
create a batch.

You can 
select any 
of your lists 
or searches.
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In the New Batch Setup dialog box, the contents of that list (nine ETF funds) are 
displayed in the list area.

7. At the bottom of the dialog box, click Schedule. The Schedule dialog box opens.

8. From the Start Time drop-down field, select 07:00.

 Note: The Start Time drop-down field uses a 24-hour clock, so 07:00 is 7:00 a.m. and 14:00 
is 2:00 p.m. The clock conforms to your local time.

9. Under Recurrence, click the Repeat on the __ day of every month button, then from 
the drop-down field, select 16.

Note the nine 
funds; each is 
the topic of a 
separate report.

The report is to run at 7:00 a.m. 
on the 16th day of each month.
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The Schedule dialog box offers flexible scheduling options to meet a variety of needs. 
The first menu in the Repeat on the area usually displays only the options First, Second, 
Third, Fourth, and Last. But when you select Day from the second menu, the additional 
options Fifth, Sixth, Seventh, Eighth, Ninth, and Tenth become available. In the image 
here, the batch is being scheduled to run on the seventh day of every other month.

10. Click OK. The Schedule dialog box closes.

11. In the Factsheet - New Batch Setup dialog box, click Save.

Monthly ETF Analysis is now listed in the Batch Reporting window.

The batch runs on the date and time listed in the Next Run Time column. When the run 
is completed, an email is sent to the person who created the batch.

Select this option first

Note the next 
run time.
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Exercise 40:   Test a batchAlthough the batch is not scheduled for an immediate run, you can test it by doing 
the following:

1. In the Batch Reporting window, select the Batch Management tab, then select 
Monthly ETF Analysis by clicking the checkbox at the beginning of its row.

2. Click Run Now. 

 Note: The number and complexity of reports being generated affect the amount of time to 
complete the run.

When the batch is finished running, a green checkmark appears in the Status column.

3. Select the Batch Reports tab, then select the Factsheet tab and click Monthly ETF 
Analysis. The view updates to display the list of batch runs for Monthly ETF Analysis.

Running the 
batch now does 
not affect the 
scheduled 
batch run.

The Last Run 
Time is just a 
few minutes ago

Note the highlighted selections.
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4. In the window, all runs of the batch Monthly ETF Analysis are listed, including old 
batches. Click the Run Date link for the batch you want to view. Because this is the first 
time the batch has been run, only one link is shown. 

 Note: Batch output is saved in the Morningstar system for two years. At the end of that time, 
Morningstar sends an email advising you of the upcoming expiration so you can save the 
output locally.

The view updates to display the list of reports generated in the batch run.

5. All reports (including outdated reports) generated from the batch run are displayed. The 
file name of each report includes the following:

g Name
g Template name
g Ticker, and
g run date in the format mmddyyyy.

To view a report, click its PDF icon. The report PDF opens. Depending on the settings in 
your internet browser, you might see a Download message.

 Note: If you do not have Adobe Acrobat Reader or a similar application installed on your 
system, an error message opens, containing a link to the Adobe website, where you can 
download Acrobat Reader.

Note the batch 
contains nine reports.

Click here 
to view 
this report.



Presentation Studio September 2018 133
© 2018 Morningstar. All Rights Reserved.

Creating a Batch Report Exercise 41:   Download all PDFs from a batch run

6. Look through the PDFs. 

Exercise 41:   Download all 
PDFs from a batch run

In Exercise 40: Test a batch on page 131, you viewed a PDF of a single report, which 
you can download. You can also download all the reports in a batch run as a .zip file. In 
this exercise, you will download all the PDFs in a batch run of Monthly ETF Analysis.

Do the following:

1. Select the Batch Reports tab.

2. Select the Factsheet tab and click Monthly ETF Analysis. The view updates to display 
the list of batch runs for Monthly ETF Analysis.

Click these icons to save, 
print, or email the PDF.

Note the highlighted selections.
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3. In the row of the run date you are interested in, click the Cloud icon. A tooltip appears, 
displaying the word “Packing.” When the reports are ready, a down arrow is displayed.

4. Click the Down Arrow.

Depending on your browser settings for downloads, one of the following happens:
g The .zip file downloads to the folder you have designated for downloads, or
g An alert opens, giving you options such as Open, Save, and Save As.

5. Unzip the file to access the report PDFs.

Click here to begin the 
downloading process.

Click here to continue the 
downloading process.

The report PDFs are shown here 
in the Downloads folder of 
Windows Explorer.
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Using Components with Nonstandard Features

OverviewMost components have properties in common with others of the same type. For 
instance, in many charts, you can change markers and colors. In many tables, you can 
add or remove columns (data points).Additionally, charts and tables in the Returns 
category offer various returns data to choose from (Return Series, Return Type, and 
so on). 

In this section, the focus is on the following:

g components with uncommon features or capabilities, and
g component features used to address specific usage,

You will learn how to do the following:

g expand a Holdings Similarity Matrix or Returns Correlation Matrix (page 136)
g customize a component to display multiple values (page 139)
gunderstand the Asset Allocations pie chart (page 141)
g compare holdings according to their most recent common portfolio date 

(page 141), and
g compare holdings in a stacked bar chart (page 143).
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How can I expand a 
Holdings Similarity 
Matrix or Returns 
Correlation Matrix?

In Holdings Similarity Matrix and Returns Correlation Matrix charts, you can expand 
the chart to fill its component cell, resulting in a more consistent and visually pleasing 
presentation. To expand the Holdings Similarity Matrix or Returns Correlation Matrix 
charts to fill its component cell, do the following:

1. In a Presentation Studio report, select or insert a Returns Correlation Matrix chart 
and/or a Holdings Similarity Matrix chart.

2. On the Command bar, select the Home tab and click Workbook. The Workbook Settings 
window opens.

Returns Correlation Matrix

Holdings Similarity Matrix

Note the highlighted selections
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Correlation Matrix?

3. In the Workbook Settings window, select the Layout tab.

4. In the Table Component Settings area, from the Table Row Spacing drop-down field, 
select Distributed: White Space Between Rows.

 Note: The other option is Consistent: White Space at Bottom.

Click here to select the 
Layout tab

Select Distributed: White Space 
Between Rows
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Correlation Matrix?

5. Click OK.

Note that the chart (or charts) now fills its cell’s vertical space.

Returns Correlation Matrix

Holdings Similarity Matrix
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How can I customize 
a component to display 
multiple values?

Most data points return only a single value—price, Morningstar Category, and so on. 
However, some data points can have multiple values. For instance, an investment can 
be available for sale in more than one country, or it can have multiple managers.

The following data points can return multiple values:

gdata points related to managers, manager history, and so on
gWrap/TAMP Availability
gCountry Available for Sale
gCountry Registered for Sale, and
gDistributor.

When one of these data points has multiple values, it displays the word “Multiple.” 
You have the option of displaying the expanded list.

The option to display an expanded list is available in both Application Settings and 
Workbook Setting. In this example, Workbook Settings in a Snapshot table are used.

1. Select a table component displaying the word “Multiple” in a column.

 Note: Columns B through E are hidden in the image for readability.

2. On the Command bar, select the Home tab, then click Workbook. The Workbook 
Settings window opens.

3. Select the Layout tab.

4. Click the Show content of “Multiple” data points checkbox, then click OK to close 
the window.

This investment is for sale 
in multiple countries.
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When using Workbook Settings, only data points in this report are affected by this 
setting. If you use Application Settings, all your reports are affected.

In the Country Available for Sale column, Vanguard S&P 500 ETF now shows 
“Mexico, United States.”

This option is also available 
in Application Settings on 
the Layout tab.

Columns B through E are 
hidden for readability.
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Why does the 
Asset Allocations 
Pie Chart sometimes 
display a bar chart?

When you select the Asset Exposure Component Category, the Component Bar 
displays the following pie chart icons:

gAsset Allocation Pie Chart
gAsset Allocation - Single Investment (table), and
gAsset Allocation - Multiple Investment (table).

The table components display as you would expect, but on occasion, the pie chart may 
display a bar chart. This component automatically converts to a bar chart if any of the 
assets have negative weights.

How can I compare 
funds’ holdings using 
their most recent 
common portfolio date?

The Holdings Comparison template compares the holdings of two funds in the 
following tables:

g Top 20 Distinct Stock & Bond Holdings (Portfolio 1 and Portfolio 2), and
g Top 20 Shares Stock & Bond Holdings (Portfolio 1 and Portfolio 2).

In these tables, the option Most Recent Common Portfolio is available. These 
components do not display data over a time period. Instead, the focus is on a specific 

Asset Exposure 
Component 
Category

Asset Allocation - Single Investment table (left icon) and
Asset Allocation - Multiple Investment table (right icon)

Asset Allocation 
Pie Chart

This chart displays a pie chart 
or a bar chart, depending on 
the asset weights.
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How can I compare funds’ holdings using their most recent 

common portfolio date?

date. The Most Recent Common Portfolio option finds the most recent common 
portfolio date for the two funds so that the dates are always in sync.

In the Holdings Comparison template, this selection is found in the Table Settings 
window when one of the following components is selected:

g Top 20 Distinct Stock & Bond Holdings (Portfolio 1 and Portfolio 2), and
g Top 20 Shares Stock & Bond Holdings (Portfolio 1 and Portfolio 2).

Select this option

Click here to display the 
portfolio dates in the table
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How does the portfolio 
date affect the end date 
in a stacked bar chart?

In a stacked bar chart representing a portfolio’s holdings, if the end date is later 
than the most recent portfolio date, the automatically adjusts to the most recent 
portfolio date.

In this sample, note the following:

gOn the toolbar at the top of the window, the end date setting for the stacked bar 
chart is Last Month End, which at the time of this writing is 7/31/2017.

gAt the top of the stacked bar chart, the Time Period is displayed as 10/1/2012 
to 4/30/2017.

gAt the top of the pie chart, the portfolio date is displayed (4/30/2017).

End Date setting for 
the stacked bar chart

Actual time period for 
the represented data

Portfolio date
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…
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